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Online GIS

For updated links to the following websites and new additions as we come across them, visit
the Contour Education Links page at:

http://www.contoureducation.com/links

Interactive Maps

Ordnance Survey MapZone

http://mapzone.ordnancesurvey.co.uk/mapzone/giszone.html

This is a brilliant site that is perfect for infroducing your students (all ages) and staff to the
basic concepts behind GIS software. The site contains lots of information on what GIS is, how
it is used in the real world as well as links to helpful sites. The best feature though is the GIS
missions — or GIS games. Each one can be downloaded and run on your school’s network
and they all have downloadable word documents that your students can use while they
undertake the GIS missions. A great starting point for anyone interested in GIS.

kmlfactbook.org
http://www.kmlfactbook.org/

The kmlfactbook.org page takes some of the global data available in the CIA World
Factbook and displays it over a 2D or 3D map of the world. | guarentee that you will find
something here that you can use in the classroom!

WWEF Wildfinder
http://www.worldwildlife.org/wildfinder/

The WWF Wildfinder allows your students to enter the common name of an animal and view
its geographic extent. Useful for studies on threatened and endangered animals as
information on the threat level and links o images are also provided.

Geoscience Australia Sentinel

http://sentinel.ga.gov.au/acres/sentinel/index.shtmi

Geoscience Australia is the federal government’s mapping and geophysical sciences
department. They have a range of great GIS data and online maps which you can navigate
to from the link, but this site is specifically good in that you can view current or recent bushfire
hotspots as well as overlay current air pressure and wind information. As well as these
features, you can search a database of hotspots across the country or in specific areas. Try
searching around Canberra in late January 2003 to see the amount of bushfires in the area.

Maps of War

http://www.mapsofwar.com/
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A great site that contains flash animations and maps of various conflicts, and more, over
time. There are some excellent resources for the two World Wars as well as current conflicts in
Irag and Afghanistan. The History of Religion and Who Has Controlled the Middle East maps
will give your students new perpectives on these topics for sure.

ShowRWorld

http://show.mappingworlds.com/world/

ShowRWorld does much the same as the WorldMapper site however here you will find a
range of topics that may not be covered elsewhere. For example you can get maps
showing you different crops around the world, the numbers of IKEA stores, numbers of
registered soccer players as well as more conventional statistics.

WorldMapper

http://www.worldmapper.org/

WorldMapper collects world maps on a wide range of useful topics. Each country in resized
to show ifs value according to the statistic you have chosen. There are maps on topics from
energy to population to demographics and even hazards and diseases.

Scribble Maps

http://scribblemaps.com/

Scribble Maps is essentially Google Maps with a built in notepad function. You can draw on
maps, add images, add text and save your creations. You can do all of this over a road
map, terrain map or even satellite image. This should be very useful for local field studies.

Reefbase

http://www.reefbase.org/gis_maps/default.aspx

An online repository of information related to the world’s reefs can be found in the ReefGlIS
section of the Reefbase website. An organisation devoted fo sustaining the world’s reef
ecosystems, Reefbase have developed a great online GIS that contains useful information
such as reef locations, threats, nitfrate and phosphate levels, sea surface temperatures and
more. Definitely worth looking at if you are examining anything from inland erosion to marine
ecosystems but be aware that some of the research data can be unreliable.

Free Software Applications
QGIS
http://www.qgis.org/

The Quantum GIS project is an open source GIS application that supports a number of
geographic file types — including ESRI's shapefile format. The software allows you to visualise,
manage, query and analyse data and to compose maps for printing. The software is free
and runs on Windows, Linux or Mac.
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Google Earth

http://www.google.com/earth/index.html

Google Earth is probably the most famous GIS application out there; whether you are
viewing your backyard or observing the pattern of urban development in India, Google
Earth can help you out. You will need to download and install the software before you can
view your world or to create your own maps. See our guide (on the Contour Education
Resources page) to using Google Earth for Virtual Field Trips for more information (and links fo
helpful Google earth blogs and online resources) on using this wonderful piece of software.
Windows and Mac.

ArcGIS Explorer

http://www.esri.com/software/arcgis/explorer/index.html

ArcGIS Explorer is a combination of ESRI's full-blown ArcGIS software and Google Earth. You
can access a variety of background maps over the 3D globe and you can very easily view
and create your own layers on top of these maps in eaither kml format or ESRI's shapefile
format. Images, videos and other content can be added to the data you create. This means
you can use the software standalone or you create specific data-sets in ArcGIS and then
view them in ArcGIS Explorer for that ‘wow’ factor that comes with viewing data over a 3D
globe. Fantastic but Windows only (sorry Mac peoplel).

AEJEE

http://edcommunity.esri.com/software/aejee/

AEJEE (ArcExplorer: Java Edition for Education) is described by ESRI as a ‘lightweight GIS tool’
and that is exactly what it is. It has more in common with ESRI's ArcGIS/ArcView software
than Google Earth or ArcGIS Explorer. It is essentially a 2D map viewer with a range of tools
that allows you fo view data and change the way the data is symbolised. You can use Excel
2003 to add data to a layer and you can also import data from your GPS — check out the
wonderful Help file that comes with the software (written by a member of the ESRI Education
Team). The download is Windows or Mac compatible and comes with some global and US
data fo get you started. Windows and Mac.

NASA World Wind

http://worldwind.arc.nasa.gov/download.html

NASA World Wind comes in two formats, an older .Net version that should be suitable for
most schools and a newer Java version. It is a 3D world viewer that allows you to view a
whole range of different base layers. Users can view the world in 3D, view world temperature
data, vegetation and landcover, various satellite images and more. Windows only.

Blogs and Geospatial Information Sites

Spatial Worlds

http://www.spatialworlds.blogspot.com/
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Malcolm Mcinerney has created this blog site as a way to record his ideas for GIS and share
resources for the teaching community. Check back regularly for more thoughts.

Geoscience Australia MapConnect

http://www.ga.gov.au/mapconnect/

The free MapConnect service allows you to view and download Geoscience Australia’s
spatial data for any location across Australia. Major infrastructure, roads and rail, localities,
landuse, contours and spot heights, and vegetation cover (and more) can all be
downloaded for free. Check out the user guide we developed for ESRI Australia to get
started http://www.esriaustralia.com.au/esri/6238.html.

Free Geography Tools

http://freegeographytools.com/

This blog updates regularly and provides links to a range of online tools related to
Geography. From websites to blogs to downloadable resources, if it is free and if it relates to
Geography, chances are you will find it here.

The Geospatial Revolution

http://geospatialrevolution.psu.edu/

The Geospatial Revolution website is an ongoing project that aims to highlight the way
geospatial technologies are changing the world we live in. There are some fantastic videos
that outline the history and relevance of spatial technologies as well as resources for
educators and links to other online resources.

Destination Spatial
http://www.destinationspatial.org/

The Destination Spatial site is a great resource for finding out where spatial technologies can
take your students. They can check out tertiary courses in the field and look at the different

professions that use spatial technologies in their jobs. Great for those students who are keen
on the technologies in the classroom.
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Google Maps

How To: Create a Personalised Google Map Online

Introduction

This document aims to show educators how they can use the freely available resources of Google to
create personalised maps for use in the classroom. With the recent boom in spatial technologies, it is
important for educators to be aware of the resources available to them and to make maximum use
of those resources to help engage and stimulate their students. There are a multitude of websites
online that provide access to specialised spatial resources but Google Maps is one of the few that
allows the user to interact and personalise their maps to some degree, it will therefore be necessary
for you to have a Google login and this will be covered in the instructions below.

Other Online Resources

For other online resources the best place to start will be an internet search. Use terms such as
‘internet map’ or ‘online GIS’ or even ‘interactive map’ and then add in key terms that will help the
search engine identify these types of sites that relate to your particular topic (i.e. volcanoes or
population density)

Contour Education has also created a YouTube video on using Google Maps which can be found
here: http://www.youtube.com/watch?v=DF yhDuoXQl

This video effectively summarises most of the content in this section of the booklet.

Step 1: Access Google Maps
Go to http://www.google.com.au/maps to get to the Australian version of Google Maps.

Gougle .

RS -
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Step 2: Register With Google

You will need to be registered with Google to access the full range of features within Google Maps.
This should take you no more than 2 minutes to complete but you will need to register with an email
address. Incidentally, this registration will also provide you with a Gmail account and access to
Google’s many other online applications (such as Google Docs).

In the top right-hand corner of the Google Maps homepage you will see a ‘Sign in’ link. Click this.

Sign in | Help

Then look for the ‘Create an account now’ link to create your new Google account. You will need to
enter your current email address and choose a password. Note that if you have a Gmail account, you
are already registered with Google.

Don't have a Google Account?
Create an account now

You will be sent an email to the address you nominated and you will need to click on a link within
this email to activate your account. Once that is done you are registered and ready to sign in. Go
back to the Google Maps homepage, click the ‘Sign in’ link and enter your account details to sign in
to Google Maps.
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Step 3: Google Maps Basics

If you have used Google Earth you will find Google Maps much more basic. You can not, for instance,
create a tour in Google Maps in the same way you can in Google Earth. However, you can place
Placemarks, with embedded information and link them with a line file to show your user/reader
where they should be moving if you would like them to visit points in a certain order. Being creative
and flexible can often solve problems!

The basic features of Google Maps can be found in the image below. Search for your location and
play with the basic features to get an idea of how the application works.

My Maps —you can
personalise and save
your maps from this
link

Search bar —you can
search for locations
(names or addresses)
here

Account information —
you can edit your
account information
from these links

Bharn

N
G rSIL

i ® Mage
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Navigation — here you can
move around the map as
well as zoom in and out. You
can also access StreeView
from the small yellow man
icon

Map Types

Map
Satellite

Hybrid
Earth

]

Map viewer —the map
data is contained in this
area of the screen

Map types — you can
change the type of map
you are viewing (see
below for more info)

A plain vector map showing main features

A satellite image (not real time)

A satellite image with some features (such as roads) identified

A 3D terrain view showing the lay of the land (similar to Google Earth)
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Step 4: Creating Your Own Map

To create your own map in Google Maps, you will need to be signed in to Google Maps. Click on the

‘My Maps’ link to access this section of the site — here you can create your own maps, view and save

other people’s maps and use more of the advanced features of the site.

Look at the My Maps section of my Google account as seen in the
image to the right. You can see some of the maps that | have
created (Created by me) as well as other people’s maps that | have
saved (Created by others). The ‘Featured content’ heading refers
to content created by Google that you can also add — there is a
distance measurement tool, Youtube videos, weather, hotels and
many many more features here.

To get started creating your own map, hit the ‘Create new map’
button. See the image below.

You will need to select a name for your map and you should also
enter a brief description in case other users find your map useful.
Finally, choose whether or not you want your map listed for the
general public. If you choose ‘Unlisted’ you can select and invite
other users to collaborate on the map privately. Once completed
you could then list the map publically if you wish.

You can also import a map that you have created in Google Earth

Gal Dipghions Ky Maps:
Create new map - Drowse 1he dractory

Crealed by me
Mipping b Joomey

sehosl and Swdgnew Tayr

Created by odfiers
Witlong's buslding
Gn The Road
EatthTools avg £l

FEopaikgll Stadijms of the Wedtd

Elgvation Contaurs
Climars Ciara Findos
Fraing Sea Leve! Anirmtion

Caigmiinl [hsi® Auilis 1Y Loicalems

Fealured conbeqt
| Boodled Ganiz Auatrelia
Videss wam YouTube

Eiibie I Ficsama YWels Adliees
Ciatamce Measurement Tool
Placos af Inlueos

using a .kml or .kmz file. Select ‘Import’ and then find the file you wish to import. Easy.

In this example | will create a map showing my school in Sydney as well as some of Sydney’s more

famous landmarks (similar to the Virtual Field Trip created in the Google Earth booklet).
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School and Sydney Tour
Uhenec fjatimn
This mmp Wil shoW oy

ol Jydaey s pobe icont

Fyivan S LR LURUE T DL T et s LR LI )
& Putiiic - Shared wilh evenong This mag will be publznad
n search resalts gng woar profies
Unisted - Shared only with salecied peunls wng have i
maps URL

When you have entered your details, hit ‘Done’.

You have now created an empty map. You will soon add Placemarks and other map elements to

provide your reader/user with some information. Find and click on your map in your My Maps

section, then hit Edit to begin editing the map.
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To place features on your map, look for the toolbar that is now visible in the upper-left corner of the
map screen.

. . Place Placemark — this
Edit features — this tool " | :
allows you to edit LTO ets ykou place a

acemark on any ma
features you have : y map
location
placed on the map 5
Draw Line — this tool Draw Polygon — this
allows you to draw a tool allows you to draw
line on the map a Polygon (or area) on
your map

For my map of Sydney | will add the following locations:
e My school
e The Sydney Harbour Bridge
e The Sydney Opera House
e BondiBeach
e Taronga Zoo

To find all of these places | am going to use the search bar and when | get to each place | will place a
Placemark and enter a name for the location, see below. If | wanted to create a map showing rivers
in my area | might use the Line tool while if | wanted to display parks in my suburb, | might use the
Polygon tool. Think carefully about the features you are mapping so that you select the appropriate
tool to use.

By Bl

o Sad - Mt Hia - et TR

Lisiere

Create your map and place Placemarks, Lines or Polygons (or a combination) and a name for each
site on your map now. As well as using the search bar, you should also use the different map types
to help you accurately locate your Placemarks, Lines or Polygons. When you have finished placing all
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of your map features on the map, check that they are listed in the correct order. You can change the
order by clicking on a Placemark in the menu to the left of your screen and dragging it to its correct

location, see below.

Privacy and sharing settings Learm maore
! Public - Shared with everyone. This map will be
published in search results and user profiles

_' Unlisted - Shared only with selected people who have
this map's URL

@ My Schoal

T T T e T T T Ay

m

Sydney Opera House

Bondi Beach

Taronga oo

@@ @<
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Step 5: Adding Content to Locations

To add content to a Placemark, Line or Polygon you have created, you will need to find the
Placemark, Line or Polygon in the menu to the left of screen and click it. This will open the feature in
the map, allowing you to edit its contents.

bhorin "-: ":- J:_E:]' e
O R
J Tl My School 9 |
| Darsc it Flon 0t = Rich fext - [&k HTH
B UF TS =T L e
nlny
i chs!
Tuarry st} g
[ Do ok
P L
apTy "
Gl Yo
{on -] ‘. > F 1 i b
A R Nt Ry Chalswood WDdio Love
¥ = . 1 '-'I'Ihm";'h" o y A T . .
R.r Lans Fove O . ."':Mu!]“-mn.'. 1
— o

As you can see in the image above, you can use ‘Plain text’, ‘Rich text’ or ‘Edit HTML’ to add
information to your Placemark. Plain text is, astonishingly, plain text. You will most certainly want to
add some colour to your feature so Rich text, as can been seen in the above image, will give you
many more options to achieve this. HTML is a little trickier and you can find some information on
entering HTML code in the ‘How To: Create a Virtual Field Trip Using Google Earth’ booklet that
accompanies this document.

For this example we will use the Rich text option to add information to our features.

Most of options here are relatively straightforward. See the diagram below for a brief explanation of
each. Following the diagram, the more advanced options (hyperlinks and images) will be elaborated
on.

\

) Underline Font ) Removes
Italics Hyperlinks ]
colour formatting

1 > [ .
B J U F-1I- e = = 1T

iz ¥

Changes
font type
Lists — Images
Highlight
Changes 'shiie numbers &
f ; colour
ont size bullets
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Hyperlinks T

A hyperlink is a link that will take the map reader/user to a designated webpage.
You can easily add hyperlinks to your features using this tool. Firstly, enter the text you wish to be
used as your link. In the example below, | will enter ‘My school’s hompage’ and use that to create
my hyperlink. Highlight your chosen text and hit the Hyperlink button, above right.

ﬁ T T T hooe . [

B
Title My School @

Description  Plain text - Rich text - Edit HTML
B 7 UFT-Tghei=zi=T &

]

L

F Delete | Cancel 0K |

You will be asked to enter a website’s URL (address).

The page at http://www.google.com.au says: lth'
e Enter a URL:
[ OK J I Cancel ]

| = ~ |

Hit cancel, go to the website and copy the URL from the address bar.

-
The page at http://'www.google.com.au says: Lﬁ

0 Enter a URL:

http://www.mowbray-p.schools.nsw.edu.au/

[ oK J [ Cancel

| ol

Use Ctrl-V or the Edit menu—>Paste to paste the address into the area, as in the above diagram. Hit
OK and your hyperlink has been created. You can also select images and use them to hyperlink so
that map readers/users can click on an image and be taken to a website.
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Images

Inserting images into Google Maps is easy. You can, however, only insert images from the internet.
The key thing to remember is that you need the URL (website) for the image that you want to
insert, not the page that the image is sitting on.

You can take your own images and upload them to one of many websites that will freely host images
and then link through to this website if you wish. Some websites that offer this service include,

e http://www.flickr.com

"

e http://photobucket.com/ m f I ick r

e http://www.snapfish.com/

facsbook
e  http://www.facebook.com - [@]phol:obucket

e http://www.myspace.com

e http://www.bebo.com

Remember that you can also link to images on other websites (for example you might want to use an
image from your school’s homepage in your Google Maps Placemark) by placing the URL in the
relevant section.

To insert an image into your feature (Placemark, Line or Polygon) place your cursor where i
you would like the image to go and hit the Image button, right. You will be asked to enter I—I

the URL of the image.

([T R NURE S —— L=

ﬂ Finase g e UNL tm wn imaae

To get the URL from an image on the internet, right-click on the image and select ‘Copy Image
Location’ or if you are using Internet Explorer, right-click and hit Properties. From here you can copy
the URL and the close the Properties box. Paste the URL into the field in Google Maps.

Vb frm

Crpg beagr

s e L
[P S—
[RSR]S—-

tad e Moo B e

Hit OK and your image should be displayed in your Placemark (or Line or Polygon) as in the image
below.
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m. |

My school's homepage.

1|

Note: If you are selecting images from flickr look for an ‘All Sizes’ link and then right-click on the

image. Select ‘View page source’ and you will view a screen similar to the screenshot below.
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You then need to find the link to the image on this page — it usually ends in .jpg.

npatible™ content="1E=kdoge">

o™ = lmage -
=Mhttp://farms5.static.flickr.com/4152/5066651018 £E£fd53a051 w. jpg™>
nical™ href="http://wyw.flickr.com/photos/ghostofwinter,/ 50 15/ ">

cent="yidth=1036">

This gives you the link directly to the image, not to the page that the image is on.

TCONINEDY. Dhusu
Ahariisgy applis

L1
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Videos

You can insert videos from any website that allows you to embed video. Go to the site you wish to
use your video from and find the embed code. See a few examples below to give you an idea of what
you are looking for.

YouTube

MetroHotels i Decemper 2005
Hotel accommodation in Sydney's CBD conveniently located anly minutes away fi..

o Like | | G5 4+ addto ~ B share

Atter making your changes bazed —_—— Lf

on your selection,

Vimeo

Embed this video

G-t thaE emnad cade

Fraview (T emfeddsd widen

InMmreE amhan EErian
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TeacherTube

Pt ey — e ey Sy S S | e e S—— ——

Eyuney Maromur Ry HEW Aumirsa -
|

Copy the embed code and go back to your Google Map.

First you need to make sure you are Editing the placemark/line or shape but instead of clicking on
the ‘Rich Text’ link, click on the ‘Edit HTML’ link.

Title

Description Plain text - Rich tex

B UFMTheisic

Now simply paste the embed code that you copied from your video earlier. Usually you would place
the video at the very end of the post. When you hit ‘Done’, your video will be embedded into your
placemark/line/shape and anyone who views this map will be able to play and view the video as

well.

Page | 17



Step 6: Saving Your Work

Once you are done, find the ‘Save’ button and click it. This will save your map, with all Placemarks,

lines and other features that you have created, to your My Maps page and allow you to keep

working.

When you are done simply hit the ‘Done’ button to save everything and close your map editing
session down. It is as simple as that. You can now move on to another map, view maps created by

other users or simple navigate around Google Maps.

leollgborals |mpod | Dang SAvE
Tifhe

School and Sydney Tour

Deacriplian

Ihis map will show my school 3F well aF some=

. T ey (I
Jyuineay' s moTe

Prbvarcy il sdput birg wbihengpy
Public: - Sharad with sverjone This map will be
pusdisned |n gearcy resulls ang user profiles
Inlksiad - Shared anly with astasiad paaplé who haes
tniz maps URL

By Sehool
My wchool's homspage

? oydney Haroou fedge

The Sydney Harbour Bridge

To get back to your map in future, click on My Maps and click on the name of the map in the menu
to the left of screen. You can begin editing again by pressing the Edit button.

Collaborate

School and Sydney Tour

This map will show my school as well as some of
Sydney's more iconic locations.

0 views - Public
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Step 7: Sharing Your Work
Finally, you will want to share your map with the world, or with your students or colleagues. The
easiest way to do this is to make your map available to the public when you are editing.

Privacy and sharing settings Learn more
) public - Shared with everyone. This map will be
published in search results and user profiles.

) Unlisted - Shared only with selected people who have
this map's URL.

You can make your map ‘Unlisted’ and then invite specific people to collaborate on the map using
the ‘Collaborate’ button while editing. The following screen allows you to invite others to edit the
map by entering their email address.

mnvite collaborators Manans collaborators

AR ST E Ty el Sy

Svw OITH H ABITRE M

Tow SR & RS A e © R Tt B Ty
T T = Gl
WY il i ¢ AR m e 11T A

A Es{E M

U PR PR N ORIVl T Tai il

As you can see, you have many options when it comes to editing and collaborating with others in the
creating of your maps using Google Maps.

VIS M e s By | bpg T Ll

Basbi i w el o (W

Another way to share a map is to ask your students to click
on the ‘Link’ option when they are viewing their map (top-
right corner of the map) and here they will be given a URL

Fants HTML 1o wmbed = abale
L ETIRRTTL IR e T TR RIS ST

which can be emailed to you or it could be hyperlinked from
a website or Microsoft Word document.
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Step 8: StreeView
Note that not all areas within Australia or the world have StreetView at this stage, many areas are
yet to be covered by Google so this application should be trialled carefully before being used in class.

This additional step is really designed to introduce you to the StreetView application that is part of
Google Maps. If you look carefully at the navigation area you will see a small, yellow man icon. This is
the StreetView icon and by dragging this little man somewhere on your map, you will be able to view
a street level image of that street.

() Cahill Expy, crouar Quay, W, Asismie
A0 B0 11 EERERH T

i] j1z I_l-

-’..-_‘"_ltl” 'H_!' _r'*"'”T""‘_I‘E' 1

By clicking and dragging your mouse, you can change the view. You can also click on the white
arrows to move the view up or down the street, although dragging the small yellow man icon does
this a lot easier.

You will also notice in the top-right corner of the
screen here that there is a ‘Link’ button.

By clicking on this button you can get some code that you can paste into your Placemark, Line or
Polygon (Paste HTML to embed in website). This will create a link to the StreetView image if you
paste this code into your feature. If you have a separate website, it will place a small map in the

website for your users to navigate.
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Paste link in email or IM =
http:/fwww.google.com.au/maps/ms?hl=en&gl=aué.ptab=38&ie=L

Paste HTML to embed in website
<iframe width="425" height="240" frameborder="0" scrolling="no'
Customise and preview embedded map

Experiment with the features of StreetView as the application is constantly undergoing changes and
updates (since it is relatively new to the Google family). You may find some exciting uses for this tool
as a way of showing your students where they are going for a field trip or how a particular
environment looks, or showing your teaching colleagues a more detailed view of where you live and

work.
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Google Earth

How To: Create a Virtual Field Trip Using Google Earth

Introduction

The following instructions will show you how to create a Virtual Field Trip using Google Earth. The
software is free and relatively easy to use which will allow most teachers to be able to put
something together for classroom use that can be shared among students or colleagues. A Virtual
Field Trip can bring the world to your students without you having to leave your computer room —
you could even run a Virtual Field Trip from a regular classroom if you have access to a laptop and a
data projector. Consider the possibilities and even check out what Virtual Field Trips other teachers
have created and placed online already — there is no need to reinvent the wheel!

Step 1: Download Google Earth

To get started you will need to download the software and install it on your computer. If you are in a
school environment you may need administrator privileges to do this so you should consult your IT
Department for advice. At home you should be able to do this without any problems.

Go to the Google Earth download page at http://earth.google.com/ and click on the following link.

Downicad Gaogle Earth 6.0

Tha word's geographic mformation at your fingesthips

Once you have downloaded the install file to your computer, double click on the
GoogleEarthSetup.exe file (See below) to install the software. The default installation settings and
locations are fine but feel free to change these to suit your needs.

: '.-:":' fiaagheEarthietup

{6
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Step 2: Review Google Earth Supporting Materials

There is an amazing amount of material online to help you use and get the most out of Google Earth.
Only a small selection of official Google sites have been provided here so use your search engine to
find more if needed.

Google Earth Help — The main Google Earth Help page, from here you can get basic help or find links

to other sites that can answer more specific questions

http://earth.google.com/support/

Google Earth User Guide — The Google Earth User Guide from Google. This page has the ins and outs

of getting the most out of Google Earth from basic user instructions through to advanced techniques
for using the software.

http://earth.google.com/support/bin/topic.py?topic=17090

Google Earth Help Forum — The new Google Earth Help Forum, you can post a question here and
experts as well as expert users will respond with advice. Very useful.

http://www.google.com/support/forum/p/earth?hl=en

There are also some fantastic ‘fan pages’, while not officially endorsed by Google they still offer
great advice as tips.

Unofficial Google Earth Blog — As the title suggests, a blog about Google Earth by a non-Google user.

Lots of useful updates and information provided here.

http://www.gearthblog.com/
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Step 3: The Basics of Google Earth
Google Earth is relatively simple to use although, like any new software, it does take some time.

Navigation Controls
— Use these to

Add Content — These tools
allow you to add placemarks,

move around
lines, polygons and other info Google Earth

to your map

Search —Your
search bar and
results

Places — A list

of places you 3D Viewer —This

have visited y Lot is the ‘map’ part

and viewed of Google Earth

Show Historical Imagery —
Access historical imagery for
1| an area and view change over

Layers — Pre- time

loaded layers
in the map

There are also many ‘keyboard shortcuts’ that you can take advantage of to help make the software
easier to use. Keyboard shortcuts are simply keys that you can use to save you using buttons and
tools from within the software. You can find an extensive list at
http://earth.google.com/userguide/v5/ug_keyboard.html.

The main keys you should initially use are summarised in the table below.

AmowKeys
Shift + Left/Right Arrow

Shift + Left Mouse Button (and Drag Upor Down)
Mouse Scroll Button

nkey
u Key

Spend some time simply playing with the software. Search for your location and zoom and pan
around the map. Practice tilting the map to get a more 3D view and experiment with some of the
other features, such as historical maps if they are available in your area.
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Step 4: Organise Your Folders

v Plocss ndd Karaze
s My Ml
VI starwng Location
+ W3 Eghnesh

You should have a folder set up on your hard drive somewhere to save all of

your work to — you will do this later. However, you will also need to create a

specific folder for your Virtual Field Trip from within Google Earth. To the left
| of your screen you should see a Places section (if it is too small, you can

5 Bl Wl '/ expand it by dragging). In here, right-click your mouse on the Temporary

DS Tamprem y Plevs
¥ 3 Syl i 3

Place a checkmark in the ‘Allow this folder to be expanded’
field but leave the ‘Show contents as options’ field
unchecked. The View tab will save the view you are looking
at as the view associated with the Virtual Field Trip. This
means that when you begin the Virtual Field Trip it will start
from this view, so navigate to an appropriate view extent
and when you are ready, hit OK. You can edit the view,
description and name later if you wish (right-click on the
folder and select Properties).

| will create a small tour showing a school in Sydney as well
as some of the main icons of the city as an example. The
image above shows you how this folder will look in the
Places section of Google Earth. You can create a tour that
covers just your city/town or that stretches across the
whole planet —there really is no limit to the extent of the
Virtual Field Trip.

saz By Places folder. Select Add - Folder and in the new dialogue box that opens,
insert the name of your Virtual Field Trip as well as a short description for you
and anyone else who may view the Virtual Field Trip.

Rooofie Larm - Lad joldes
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Step 5: Place Placemarks

You will now create your individual placemarks for each stop on your Virtual Field Trip. Create these
inside the folder you created in the previous step. The order in which you create the placemarks
does not matter now as you can edit the order later but be aware that the Virtual Field Trip will play
through the placemarks from top to bottom as they are listed in the folder. To give you an example, |
will create placemarks for the following:

e My School

The Sydney Harbour Bridge

The Sydney Opera House

Bondi Beach
e Taroonga Zoo

The Placemarks will be created in the order listed and the Virtual Field Trip will follow that order
when complete.

To create a Placemark, simply right-click on your Virtual Field Trip folder (School and Sydney Tour in
this example) and select Add—> Placemark (as can be seen in the image, below). You can then drag
the pushpin icon to your exact location and begin to edit the placemark content; although just
create the placemarks now with a descriptive name (leave default settings) and we will edit content
in the next step.
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Step 6: Edit Placemark Content

Once you have created the placemarks, you will want to change how they look and add some

content to each to make them a little more interesting. You can add any amount of text as well as

images or hyperlinks to each placemark, although you should consider placing an appropriate

amount of information at each point so as not to bore
your students.

Now go back to your first Placemark by double-clicking
on it in your Places section. Google Earth will zoom to
the extent you were viewing when you saved the
Placemark. During your Virtual Field Trip, the map will
zoom back to this extent so zoom in or out to get this —
right. For an example, see the image to the right

showing my school and the extent it will be seen in the
example Virtual Field Trip. Note that is does not have to be
oriented with North to the top of the map and you can also tilt
your map to provide a different viewpoint.

To change this extent, right-click on the Placemark under the
Places section. Zoom to the extent you want your Placemark set
at and then, under the View tab, hit the Snapshot Current
Extent button to save this extent. See the image to the right for
assistance.

You can also edit the icon of the Placemark that is used to
identify your locations. To the right of the name field there is a
small Placemark icon. Click this button to see all of the options
available to you, just make sure you select appropriate icons for
the different features you are mapping.

Finally you will want to edit the content of the Placemark so that when the Placemark is clicked it

shows the user useful information. You can enter text as well as images and hyperlinks to websites.

So if you have a video, it is best to upload it to a video hosting website (www.teachertube.com or

www.youtube.com, but be aware that many schools ban Youtube now) and then place a link to the

video in your Placemark.

All of the visible content in the Placemark is contained in the Description area of the Placemark and

HTML coding is used to create more advanced elements, such as hyperlinks and images, in this

Description area.

There are some rules as to how you should enter data into the Description filed to help you properly

format your information. The table below summarises some of the main HTML code that you will
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need to use but if you have knowledge of HTML feel free to experiment and see what you can do.
Note that the text in red will need to be changed by you to suit your specific needs.

<BR> Inserts a break into your page

<CENTER> and </CENTER> Opens and closes text/object centring

<IMG SRC=* ”> Inserts an image from a website, note the URL
is required

<IMG SRC=" " WIDTH=“00¢" HEIGHT= “00¢"> Inserts and resizes an image from a website,
note that you need to manually enter the
value of pixels to resize he image to.

<A HREF=“ Inserts a hyperlink

By entering the following text into the Description field, | was able to get the Placemark content to
look like the screen capture further down the page. Note that the image links to a website image
and it has not been resized; you could make it smaller or larger if you wish.

This centres This is the URL

the image for the image
<CENTER>
<IMG SRC="http://farm1.st®¥ic.flickr.com/60/173307180_9ba53f8796.jpg">
</CENTER>
<BR> o&— These breaks place gaps between
This is one of the playgrounds at my school. elements (ie the image and text)
<BR>
<A HREF="http://www.mogbray-p.schools.nsw.edu.au/frameset.htm">Mowbray Park State
School</A>
<BR> &—___

A final break neatens This is the web address

This is the text that

off your content for the hyperlink
will appear to be

clicked on
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Step 7: Managing Images

Managing your images is crucial to your Virtual Field Trip as you could save your Virtual Field Trip
without your images by accident. Follow the steps below to make sure that when you save a Virtual
Field Trip it will save all images as well.

Online Images

In the previous example you used an image from the internet to insert into your Placemark. You can
take your own images and upload them to one of many websites that will freely host images and
then link through to this website if you wish. Some websites that offer this service include,

e http://www.flickr.com

e http://photobucket.com/

e http://www.snapfish.com/

e http://www.facebook.com

[(J photobucket

e http://www.myspace.com

e http://www.bebo.com

Remember that you can also link to images on other websites (for example you might want to use an
image from your school’s homepage in your Google Earth Placemark) by placing the URL in the
relevant section in the Description field (see previous step).

Using Your Own Images

You can also include images that are saved onto your computer in your Google Earth Placemarks
however, many users have noted some problems with this method. The image is saved within your
.kmz file which can massively increase the size of these files, making them too large to email or even
copy. Secondly, some users have found that the images do not reliably save to the .kmz file meaning
that when they are needed in the future, they simply do not open. If you are linking to an image on
your computer and you then save your .kmz file to be used elsewhere, | would strongly recommend
you test and retest the .kmz file on a number of other machines to make sure that it will work for
you — there is nothing worse than expecting a wonderful image to show up (especially in class!)
when nothing in fact does pop up for you. For more information on .kmz files, see the following
steps.
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Step 8: Saving Placemarks as .kml Files * Piaces ot o

Once you have completed editing the content within each of your : E-_-Qﬂ:;mm

Placemarks, you can begin the process of saving your work. Before you -

begin make sure you have a folder set up somewhere on your hard drive e

to save all of your work into. “1. SolancHeshou Prdoe
) b s

This starts by saving each Placemark individually. The image to the right

shows the completed folder configuration for my Virtual Field Trip. Note e

that the Placemarks are in the order in which | want to VFT to take place. 2] TuseunZos

If this order is not correct, you should click and drag the Placemarks up or

down to get the desired result.

Now simply right-click on the first Placemark, in my case My School, and select ‘Save Place As...".

You should navigate to the folder on your hard drive in which you will save your work (you set this
up in step 4) and save the file as a .kml file. It is best to call the file what you have called it in Google
Earth to remove confusion.

Change the
filetype to .kml
here

iy Swen e ]
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Do this for all of your Placemarks so they are all saved in the one folder on your hard drive. These
can be opened in future, using the File>Open option in Google Earth but as .kml files they will only
open individually. You will save your Virtual Field Trip in the next step.
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Step 9: Saving Your Tour as a .kmz File

Once all placemarks have been saved, you will save your Virtual
Field Trip as a ‘package’ using the .kmz file format. In step 4 you
created a folder, within Google Earth, to house all of your
Placemarks. In the example provided to the right it is the ‘School

L

t-'a.:-cilnn'hu:

and Sydney Tour’ folder. || Saeinr:tshnus Eeder
1) St Cipeny bociy
£ | BpndiEuaarh
Right click on this folder and click on ‘Save Place As..." again. This
time you will need to change the file type to .kmz. See the example 20 Tusmusdes
below.
File name; | [Saiis 1 Svdne I
Save as type: |Km.z {"kmz) 'I
= Hide Folders | Save | | |

This will package all of your Placemarks into a portable file that you can copy and move to other

computers. In theory, any images that you have included from your computer will also be included
within this file (although there have been problems reported with this method, see step7 for more

information). If you have included links to internet images in your .kmz file you will need to ensure

that any other computers you are using have access to the internet
images.

to be able to display those

Once you have saved your .kmz file it is advisable to close down Google Earth and reopen the
software to test your new file. Once you have reopened Google Earth, go to File>Open and

navigate to your recently saved .kmz file. Open it and see if all of the Placemarks are working as you

saved them.
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Step 10: Playing Your Tour

Playing and using your tour is easy. This is really the step your students will take if you have created
a Virtual Field Trip for them to use in class. Once you have opened your .kmz file in Google Earth it
should display as in the image below. You will see the.kmz file with a folder underneath that has the
same name. Inside that folder, all of your Placemarks will be visible.
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To play the Virtual Field Trip, click on the Folder (not the .kmz file name) and hit the Play Tour
button, circled in the image above. The software will fly you to each Placemark and sit on the extent
that you saved with each Placemark for a few seconds. You can stop the Virtual Field Trip at any time
to view the information that you added to each Placemark and then hit the Play Tour button again
(or use the tour toolbar at the bottom of your screen) to carry on. You can also double-click on any
one of the Placemarks in the menu above to fly straight to that location.
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Step 11: Sending Your Tour To Others

Finally you will want to be able to move your Virtual Field Trip to other computers for others to see
and use. This is also very easy to do as long as you have completed all steps above. Once you have
saved the .kmz file you can simply copy that file to a hard drive or USB drive and pass it on to your
colleagues or students. You can save the .kmz file to a website for people to download (you will find
many more online if you search, see below) or you can even email the file if there are no large
images associated with the .kmz file (some schools have strict limits on email download sizes). It is
important to create and share your Virtual Field Trips as there may be other educators who would
love to see what you have created.
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Enjoy playing with Google Earth and make some time to practice — it is well worth the effort!
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Classroom Ideas
Here are just a few ideas to get you started using these applications in your
classroom. Remember that even using a simple online GIS such as
Whereis.com is using spatial technologies. Practice, play and enjoy the
results.

Use some of the online GIS to get your students oriented to the basics of using spatial technologies
and the concepts involved.

Create a virtual field trip for your students so that you can visit a location in your local area, in
Australia or even somewhere else on the planet entirely without leaving the classroom.

Have your students present their field trip results using a Google Earth or Google Maps interactive
map. You can include images of figures such as their field sketches, research findings, digital images
or even video that they have collected on the day.

Use Google Maps or Earth to help your students prepare for an upcoming field trip by giving them a
greater understanding of what natural features they will encounter on the day. Incorporate
websites, images and links to online video to help prepare them for their trip.

Have your students, working in small groups, collaborate on a Google Maps map. They can work on
the map from home as well as at school and they can include other information to help them make
their point. For example, the map could show the areas around Queensland or Australia where a
particular native species is under threat or parts of the local area that show evidence of the different
types of erosion. You could even map weeds around the school using this method.

Have your students create a short story that uses Google Maps as the ‘book’. Your students will need
to firstly, create a story that incorporates some spatial or geographical elements (this could be set in
their local area or across the planet). Then your students would need to create the placemarks in the
correct order such that their story was told in a meaningful way. By clicking on each placemark, the
reader would be taken to that part of the story and your students could have the story written into
the details section of the placemark. Just make sure that they incorporate the map or satellite
imagery in some way into their story.
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